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Summary

The Hazardous Material Life-Cycle Cost ModelfHMLCCM) was developed to estimate the total

life-cycle costs of using various hazardous materials in the construction, maintenance, and repair

of U.S. naval systems and facilities. The model estimates those costs derived from the need to

protoct the health and safety of workplace personnel and the need to protect the environment.

The purpose of this guide is to prcvide users with a detailed description of the system as well

as the basic structure and features of the HMLCCM and instructions on how to use the system.

This report is an updated version of the original user's guide. Changes include added

functionality by including permissible exposure levels (portion of OSHA Z-Table) and on-line

access to Material Safety Data Sheets (MSDS) based on the current Hazardous Information

System (HMIS).
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Section 1 Introduction

1.1 Purpose of the Hazardous Material Life-Cycle Cost Model

In 1987, the Chief of Naval Operations (CNO) instructed all Navy commands to
reduce the amount of hazardous waste by 50 percent by December 1992, using
1987 levels as their baseline. To accomplish these goals Navy personnel are
implementing management control practices and up-to-date technology. The
Hazardous Material Life-Cycle Cost Model (HMLCCM) was developed to assist
Navy personnel in conducting cost analyses when making decisions about the
procurement of various hazardous materials. The HMLCCM aggregates the costs
derived from actions taken to protect the health of the worker or to preserve the
environment when a particular hazardous material is used.

1.2 Cost Factors

The primary cost of using nonhazardous materials is procurement cost; however,
when using hazardous materials (HM) added expenses are incurred because of the
need to protect the individual's health and the environment. The added expenses
that elevate the basic procurement cost of a material can be grouped into a set of
cost factors. Cost factors identified by interviews with experts in the field (see
The System Manager's Guide) were included in the initial H-IMLCCM. These are
as follows:

Claims and Processing claims, monitoring cases, conducting
Compensation interventions to resolve problems, assessment of

liability, and providing appropriate payment.

Disposal Discard, permanent contwinment, or treatment to
eliminate the toxic potential of a hazardous
substancL, product, or waste.

Engineering Construction, maintenance, and repair of structural
Controls equipment used to prevent personal and

environmental exposures to hazardous materials.

Fines and Penalties Costs incurred because of federal, state, or local
safety and environmental regulatory violations,
including improper or incomplete recordkeeping,
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unsafe working conditions, and environmental
pollution.

Medical Medical consultations, examinations, tests, and
Surveillance procedures, including baseline and periodic, as

well as event-driven medical encounters.

Medical Treatment Medical care for occupational injuries or illnesses
due to exposure to a hazardous substance, product,
or waste.

Permits and Local, state, and federal permits required for
Certification transportation, storage, and use of certain

hazardous materials at a facility.

Personal Protective Gear that is issued to individual workers to
Equipment (PPE) prevent exposure to hazardous materials, including

maintenance, inspection, distribution, replacement,
and inventory.

Procurement The initial cost of the material.

Spill Containment Responses to spills of hazardous materials,
and Cleanup including costs of equipment and personnel.

Storage Storage of the hazardous material before use, and
storage of any resulting hazardous waste before
disposal.

Training Instructions regarding the legal requirements
pertaining to hazardous materials, and information
regarding methods and procedures for minimizing
the risk of exposure to a hazamdous material.

Workplace Surveys, inspections, and monitoring of the
Monitoring workplace, processes, materials, and personnel for

the purpose of maintaining the health and safety
of workers, and to protect the environment.

Introduciion a 3 2



1.3 Cost Elements

Cost factors are broad categories of individual cost components that when
combined make up the total HM use cost Cost elements are subcategories of cost
factors. Cost elements make up the cost factors, similar to the way cost factors
make up the total HM use cost. For example, personal protective equipment
(PPE) is a cost factor, however, there are many different kinds of personal
protective equipment such as gloves, respirators, and boots. These are the cost
elements for the cost factor PPE. Thus, the cost of a factor is computed as the
summation of the cost elements associated with the factor.

1.4 Cost Items

The expenditure for a cost element depends on the specific item acquired. For
example, gloves may cost bemween $1.00 and $25.00 per paii, depending on the
type of glove purchased. The various products used to meet the requirement of
a cost element are called cost items. Each cost item has a unique price.

Inrroduction a 1 3



Section 2 HMLCCM Software Summary

2.1 Programming Language

The HMLCCM software was developed using Microsoft's FoxPro. FoxPro is a
database management system created for the personal computer.

2.2 Secu.ity/Privacy

The security module will maintain user passwords, which allow logon access to
the HMLCCM program and database files. Menu options are assigned to the user
through a security key system in FoxPro. HMLCCM does not collect or store
Privacy Act data.

2.3 Maintenance

The primary maintenance functions consist of security, file and format definition,
user file updates, and data initialization.

2.4 System Organization

The HMLCCM has four modules or user options (described in Section 4), which
include Cost Analysis, Reference, Set Parameters, and System Maintenance. To
access the Set Parameter option a password is required.

HMLCCH Software Summary 3 4



Section 3 Accessing the System

3.1 Logon to HMLCCM

At the MS-DOS prompt, (C;-I\JMLCCM) type HMLCCM and the security prompt

will display:

Type in the password and press Enter or "Carniage Return" <CR> If the
password is unknowni press <CR>. The password allows the user to access the
set paramete's option. If the user is unable to provide the appropriate password,
reference, maintenance, and cost anelysis will be the only options accessed. A
brief greeting will be displdyed befo~re the following desktop appears:

If yt~m '11. Idt " ' Window

The parts of the menu 3ystem are shown on page 6, along with steps for choosing menu options with the
keyboard and mouse. If your system does niot have a mouse you will need to use the keyboard.
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3.2 Choosing Menu (Cytions With the Keyboard

Selecting Menu Pads and Menu Options are exccutcd differently when using the keyboard. The
following are instructijns on how io select Menu Pads and Menu Options with the keyboard.

3.2.1 Selecting Menu Pads

Four Menu Pads are available to the user: System, File, Edit, and Window. Press the Alt key
in conjunction with the first letter of the Menu Pad you want to selecL For example, if you
want to access the File Menu Pad press Alt F.

3.2.2 Selecting Menu Options

A Menu Popup appears, containing a list of Menu Options, when a particular Menu Pad is
selected. There are two ways to select a Menu Option using the keyboard:

1. Press the T or I, keys to highlight the desired Menu Option and press
<CR>.

2. Type the bold letter of the Menu Option you want and press <CR>.

sysotn . , a1 ... • dit - Window l:

Printer Retup..

3.3 Choosing Menu Options With the Mouse

1. Point to the Menu Pad and press the Left mouse button to display the menu
popup

2. Point to the desired option and press the Left mouse button.

Accesst:8 the System U 0 6



3.4 Logout of tIMLCCM

To return to the MS-DOS prompt, Choose Quit from the File Menu Pad.

System File ______ 3dt Window

Printez Setup..

Quit~

Accessing the System U N 7



Section 4 Systems Operation

4.1 Cost Analysis

To calculate how much it will cost to use a particular hazardous material you will first need to

define the circumstances in which the substance will be used. For example, you may use 5

gallons of lead-based paint or 4 gallons of PD-680. Specification of the circumstances for using

a hazardous material is called the hazardous material scenario. Each scenario consists of one
or more steps. For each step of a scenario, a material, phase, process, number of people,

number of days, and quantity of material must be defined. To create a scenario follow the
instructions outlined below.

1. Choose HMLCCM from the System Menu Pad.

An option menu will appear on the screen.

2. Choose Cost Analysis from the option menu.

This will direct you to the Build Hazmat Scenario prompt as shown below:

Help... Fl.

Calculator

..IW=sN Anaysi '....... 4 KA~MT :Sceniario

OSHA Z-Table

Reference Material

S',stem Maintenance

Set Ptrameters

3. Press <CR>.

Accessing the System a 3 8



The following box will appear:

Cost Analysis

Scenario:

(HeW> <Retrieve> <Delete> <Browse> <Cancel>

You are now in the Cost Analysis option. You can do two things: (1) you can define a new scenario,
or (2) you can retrieve an already existing scenario.

4.1.1 Defining a New Scenario

1. Type in a file name and press <CR>.

The cursor should default to the submenu below and highlight
New.

2. Select New from the submenu below and press <CR>.

The following screen will display:

ILAZAIOUS KATERML BCENARIO

Step # 1 Scenario: 1 Example

Material: < Add >
Phase: < Edit >
Process: - Next •

<Previous>
< Exit >

Number of Employees: Number of days:
Quantity of material: Unit:

< Save > <Cancel>
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Note: The users can only input materials, phases, and processes that have previously
been defined. To ensure that you are using an item that has previously been
defined type ? <CR> to access the list of choices.

3. Type in the name of the hazardous material used and press <CR>.

4. Type in the phase and press <CR>.

5. Type in the process and press <CR>.

6. Type in the number of employees who performed the process and
press <CR>.

7. Type in the number of days that the process took to complete and
press <CR>.

8. Type in the quantity of material used in the process and press
<CR>.

Note: The unit of material is defined when the material is defined; therefore, the unit
will never need to be input at the hazardous material scenario screen.

9. Select Save on the submenu below and press <CR>.

10. Select Exit on the side menu and press <CR> (Skip to Section
4.1.3 Step 5).

4.1.2 Defining a Scenario With Multiple Steps

A scenario consists of one or more steps, in which each step specifies a material,
phase, process, number of people involved, the duration of the task, and quantity
of material. Steps enable the user to calculate costs for the separate components
of a complex process. For example, one may want to determine the cost of
painting an airplane where both the construction cost and maintenance cost are of
interest. The components or steps of this process might include applying the paint
during construction, and then stripping and repainting during the maintenance
phase. Therefore, the hazardous material scenario would consist of the steps
found below:

Step 1: Step 2:
Material: Lead paint Material: Methylene chloride
Phase: Construction Phase: MaintenancelRepair
Process: Spray painting Process: Faint stripping
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Step 3:
Material: Lead paint
Phase: Maintenance/Repair
Process: Spray painting

Once you have identified the steps y( will need to enter them into the HMLCCM.

First follow the instructions in 4.1.1 (Defining a New Scenario) for entering in Step 1. After you
have defined a scenario you will notice that at the top left comer will be Step 1 and zhe top right
comer will be the scenario name. To create another step follow the instructions below:

1. At the scenario dialog box, select the scenario you just created by typing in the
name.

The hazardous material scenario material dialog box will appear on the screeen.

2. Select Add on the side menu.

3. Input the material, phase, process, quantity of mawrial, number of employees and
days.

After you have done this you will notice that it is now Step 2.

4. Select Save on the submenu below and press <CR>.

5. Select Exit or, the side menu and press <CR> (Skip to Section 4.1.3 Step 5).

4.1.3 Retrieving a Scenario

If you do not want to define a new scenario, you have the option of accessing a scenario in the
database that has been previously defined. To retrieve a scenario that already exists follow the
instructions on the next page.
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1. Type ?<CR>

A list of all the scenarios in the database will appear on the scr'~en (shown below):

select -A Malttedalscefwro

M "N

2. Select by using the Tor . keys until the scenario you want to

retrieve is highlighted.

3. Press <CR>.

The cursor will default to the submenu below and highlight

retrieve.

4. Select Retrieve and press <CR>.

5. The scenario you have selected will appear.

6. You may move the cursor to the Side Bar option you wish to
select. If you want tc compute the cost, move the cursor to
<<Exit>> and press <CR>.

A dialog box will appear asking you if you want to do
computations now.

7. Press Yes and <CR>.
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The following box will display:

COMPUTE COST VALUE

Estimated Estimated
Cost Scenario: 1 Exanple Variance

for Product: (

I for Stop:(

for Factor:

for Factor: at step: [ l

C) for Phase: MAI NCE/REPAIR C)

# of iterations Total of Scenario Cost: ( ) Yes ( ) No

< OK > <Browse> <Cancel>

Note: For a review of the terms used in this menu see Appendix A.

4.1.4 Selecting Computation Options

This option allows the user to calculate the estimated cost of a scenario or a portion of a
scenario. In addition, the user can derive variance for the cost estimate using a bootstrap
analysis.

4.1.4.1 Cost Estimate

The cursor will appear in the first Cost Box. If you are using a
keyboard use the +- and -4 keys to move to the next option.

The following list describes the functions of each of the cost boxes:

Cost Box 1: Computes the estimated cost for all materials or a
specific product.

Cost Box 2: Computes the estimated cost for all steps in the scenario or only
one step.

Cost Box 3: Computes the estimated cost for factors across all steps.

System Operation 6 0 13



Cost Box 4: Computes the estimated cost for a particular factor at a particular
step.

Cost Box 5: Computes the estimated cost for a particular phase.

If you are interested in the total scenario cost, for example, the total cost to paint
an airplane, select the "Total of Scenario Cost" radio button at the bottom of the
screen.

For selecting the cost computation option follow :he instructions below:

1. Select the cost box on the left side of the screen by positioning the cursor on the
box and pressing <CR>.

2. Move the cursor to the option box parallel to the compute box and press <CR>.

A dialog box will appear displaying your options.

3. Highlight the option you want and press <CR>.

Note: If your scenario includes more than one step and you have defined these steps you
will have the option to compute cost for all the steps or for only one of the steps.
If you have not defined more than one step you will only be able to compute for
that particular step.

4.1.4.2 Selecting Variance Options

The Variance Box allows the user to conduct a bootstrap analysis to determine the variance of
a cost estimate. The results are presented as the mean and standard deviation of a set of samples.
The user determines the number of samples by specifying the number of iterations.

Note: The System will only allow you to estimate the variance of one
cost factor at a time.

For selecting a variance option follow the instructions below:

1. Move the cursor to the Variance Box and press <CR>.

Finish selecting any cost options before you continue.

2. Select the number of iterations by entering the number in the box
to the left and press <CR>.

Note: The default value for iterations is 200. Using this value will
require several minutes of computer time. The user may select a
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smaller value if desired, however, larger values will yield more
accurate estimates.

3. Select <OK> on the bubmenu below and press <CR>.

A dialog box will appear with several variance options.

4. Select by highlighting the option and press <CR>.

A message window will appear with "Calculating" in the box until the estimated
cost and variance results appear.
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4.2 On-Line OSHA Z-Table

The user may need to reference the personal exposure limits for a particular chemical substance. This
option displays an online reference table, named TLV, which is a subset of ihe OSHA Z-Table set forth
by the Occupational Safety and Health Administration Uinited States Department of Labor. Information
given in the table includes Chemical Abstract Number (CAS Number), Time Weighted Average (TWA),
and Short Term Exposure Limit (STEL). To view this table follow the steps below:

1. Choose HMLCCM from the System menu.

An option menu will appear on the screen.

2. Choose OSHA Z-Table from the option menu.

3. To view full screen press Ctrl-FI0.

4. Return to desktop by pressing Esc.

4.3 On-Line Hazardous Materials Reference

An on-line reference option is available, which allows the user to retreve the Material Safety
Data Sheet (MSDS) which includes information, such as: Synonyms/Trade names, Common uses,
Descriptions, Chemical/Physical Properties, Occupational Exposures, Exposure limits, Health
Hazards, Medical S irveillance, Special Tests, Personal Protective Equipment, and Treatments.
To access this inforr"ation follow the steps below:

1 . Choose HMLCCM from the System menu.

An option menu will appear on the scren.

2. Choose Reference from the option menu.

stem File Edit Window

Help... Fl

Calculator

IIMUMC ,. Cost Analysis •

OSHA Z-Table

Reference Materie.l

Sy.tem Maintenance

Set Parameters
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The f'ollowing box will appear:

MATERIAL:

< ok > Cancol >

3. Type'? and press 'cCR>.

A list of all the materials in ýhe database will appear on the screen (shown below).

nv\ -,Select ael

Z ~TROZ1UTHAWLOL$<

3ý,N

4. Select by using the T or IL keys until the material you want is highlighted.

5. Press <CR-..

The cursor will default to the submenu below and highlight OK.

6. Select OK and press <CR>.

The screen will display the hazardous material you selected and the information
found on the MSDS as previously mentioned. To scroll down the screen use the
T and .L keys.

4.3.1 PrntI On-Line Reftrence Information

Occasionally you will want to print the reference information that appears on the
screen to do this follow the instructions below:

At the on-line reference screen:
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1. Press Shift and Tab at the same time to move the cursor to the
submenu belew.

2. Select Print and press <CR>.

4.3.2 Select Another Material
If ynu would like to display a new hazardous material without returning to the Menu Pads you may
follow the directions beluw.

At the on-line reference screen;

1. Press Shift and Tsb at the same time to move the cursor to the submenu below.

2. Select Another and press <CR>.

4.3.3 Exit On-line Reference

1. Press Shift and Tab at the same time to move the cursor to the submenu
below.

2. Select Exit and press <CR>.

4.4 Maintenance

Occasionally you will want to back-up your files onto floppy disks or to upload data that was done on
another computer. To perform these functions follow the instructions listed below:

4.4.1 Backing-up files

1. Choose HMLCCM from the System menu.

An option menu will appear on the screen.

2. Choose System Maintenance from the option menu.

Another option menu will appear on the screen.

3. Choose Back-Up (floppy) from the option menu (shown below).

The computer will prompt you to insert your diskette. Put your diskette in drive A and follow
the computer's directions.
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ut•m Vrile Edit Window

Help... Fl

Calculator

WM4CON Cost Analysis a

Roterence

System Maintenaneen Bac-k-up (floppy)---

Set Parameters Upload Data

4.42 Upload ing data

Put a diskette in drive A. Follow the computer's directions.

4.5 Set Parameters

To access the Set Parameters option the user has to provide a password when logging onto the
System. For instructions on setting parameters see The System Manager's Guide.
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Section 5 Menus

The HMLCCM commands appear in two menus: System and File. The Edit and Window menus
contair commands that the user will not need to access.

Systsm Pilo Zdit Wi ndow

A command is an instruction to your computer to carry out an action, such as printing a
document. When you pull down a menu, you will notice that some commands appear in dark
text while others are dimmed. You can use the commands in dark text immediately. but you
cannot choose a dimmed command until it becomes dark.

5.1 The System Menu

The System menu contains the commands for logging on the HMLCCM system and desk
accessories, such as the Calculator and Help.

Help.... F l
Calculator

HMLCCM

5.1.1 Help

The HMLCCM system offers on-line help. The Help contains instructions
describing all the HMLCCM functions. Select Help from the System menu or
press Fl. A Help ,indow will display with general topics, commands, and
functions. The Help window can be scrolled by using the arrow keys on the
keypad. To find the topic you want, you can scroll through the list or, while you
are in the Help window, type a letter or series of letters to select the first list item
beginning with the specified letter(s).

5.1.2 Calculator
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The system has a four-function pocket calculator that will appear on the screen when you select
Calculator from thc System menu. The Calculator is used like a standard pocket calcula'or.

Calculations can be performed using the keyboard or the mouse.

00.

MC "7 8 9 / "
MR 4 5 6 *

M+ 1 2 3 - C

M- 0 . + 8

With the keyboard, you can type the equation as it would be written. Most Calculator keys have the
same keyboard equivalents, with the following exceptions:

_Keystroke Equivalent

Q I

MR

N ±.

A M+

Z MC

S M-

To calculate 8 x 16 + 23 and take the square root of the result using the keyboard:
Type 8"16+23=Q. The result is 12.28.

To perform the same calculation with the mouse, simply click on the appropriate numbers and
symbols on the Calculator.

5.13 HMLCCM

This option allows the users to access the system. The system contains four options: Cost
Analysis, Reference Materials, System Maintenance, and Set Parameters.
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5.2 The File Menu

The File menu contains the commands for printing documents, and ending a work session.

Printer Setup
Print....

Quit

5.2.1 Printer Setup

Printer Setup displays the Printer Setup dialog.

Printer Setup:

Print to: PRV

<File... >

Print On Left Margin!
(.) Print OfU Right Margin:

< OK > <Cance' >

In this dialog, you can choose a print device from the Print to popup. If you choose File from
the popup, you could specify a file to which output will be sent. To do this, type a file name
in the text box.

Adjust the settings for left margin and right margin, if necessary.

Choose the Print On and Print Off radio button to enable or disable output to the printer.

When your settings are correc:. choose OK to activate them or choose Cancel to exit the dialog
without changing the current print settings.
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5.2.2 Print.

When you select Print from the File menu, the Print dialog displays the following menu:

Print:

Windows:

<File... >

Line Numbers
[ Page Eject Before
[x] Page Eject After

_ _ _< UK > <_Lancel>

Choose the source from the Windows popup. To print the contents of a file that is not currently
open, choose the File option from the Windows popup. Then, in the text box, type the name of
the file you want to print.

When the Line Numbers check box is checked, HMLCCM automatically adds line numbers to
the output.

When the Page Eject Before check box is checked, HMLCCM sends form feed to the printer
before printing. When the Page Eject After check box is checked, HMLCCM sends a form feed
to the printer after printing.

Once the settings in the Print dialog are correct, choose OK to confirm your choices or Cancel
to exit the dialog without taking action.

5.2.3 Quit

Quit ends your HMLCCM session and returns you to the system prompt.
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Appendix Terms and Abbreviations

Browse To display data in a Browse window.

Bootstrap A method for estimating the variance of a variable from a set of observed values.

Carriage Return A command that is usually accessed by the Return key or the
<CR> Enter key.

Check box A pair of square brackets followed by text. Settings can be turned on and off by
choosing the check box. If a check box has an X in it the setting is on.

Choose To select a command or an option from a menu, or a control in a dialog.

Default A preset response to a question or prompt. The default is automatically used by the
computer if you don't supply a different response. Default values prevent a program from
stalling or crashing if no value is supplied by the user.

Desktop The screen that underlies all system and user-defined windows is called the desktop.

File Any name that identifies a file.

Highlight To make something visually distinct. For example, when you select a block of text, the
selected text is highlighted.

Highlighted Text that is emphasized so that it stands out from the surroundings. Highlighting
something typically indicates that it is selected or is about to be chosen. Highlighted text
may appear differently, depending on the type of monitor and color settings that you use.

HMIS Acronym for Hazardous Material Information System.

HMLCCM Acronym for Hazardous Materials Life-Cycle Cost Model.

HM Acronym for Hazardous Material.

HW Acronym for Hazardous Waste.

Menu A list of choices presented by a program, from which you can select an option.

Menu Bar A horizontal strip that appears at the top of the screen and contains Menu Pads.

Menu Options Commands, found on the Menu Popups, that perform specific actions.
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Menu Pads A word, phrase, or icon on the Menu Bar that designates one menu. Positioning the cursor
on a menu title highlights the title and display its options below it.

Menu Popup List of related options. When you choose an option from a menu popup, you are telling

the HMLCCM system what action to take.

Menu System The combination of the Menu Bar, Menu Pads, Menu Popups and Menu Options.

MSDS Acronym for Material Safety Data Sheet.

On-line help A mini-reference guide, accessible while using the HMLCCM system, that provides

additional information about HMLCCM commands and functions.

Options A list of actions to choose from that are listed on a menu.

Phase A level in the evolution of a system or product (e.g, construction,
or maintenance/repair).

Prompt A message on the screen that tells you of some need for response or action. A prompt

usually takes the form of a symbol, a message, a dialog box or a menu of choices.

Process The operation or treatment that utilizes the hazardous material
described in the scenario.

Radio button A set of parentheses followed by text. Radio buttons are grouped so that only one can
be chosen at a time, like the buttons on a car radio. Choose a radio button to activate it.

When a radio button is chosen, a bullet appears in the parentheses and any previously
chosen radio button becomes deselected.

Scenario The specific circumstances that define how a hazardous material is used.

Step A component of a task that can be defined in terms of the material, process, and
personnel that are required to accomplish the task.

Apprndix A 8 0 25
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